
    Delrina TEST Help Contents

Online help is provided for all dialogs, commands and procedures in the Delrina TEST utility. Each help panel 
displays a brief explanation of the appropriate topic and provides references to other help panels.

For additional tips and information, click highlighted jump and pop-up text.

For information on one of the topics shown below, click the appropriate icon.

Menus and Commands

Procedures



 Menus and Toolbar

Menus are lists of related commands, grouped together under a menu name identifying their common function. To 
display a menu, click the menu name. A drop-down list of menu commands appears.

The Toolbar is displayed across the top of the window, below the menu, to give quick mouse access to frequently 
used functions or commands.

For more information, click a menu name on the menu bar or an icon on the toolbar, shown below.



File Menu

For more information, click a command on the menu shown below.



New Command - File Menu

Use this command to clear the current log file from the screen.



 Print Command - File Menu

Use this command to print the current Delrina TEST Log File. 

When you select the Print command, the Customer Information dialog appears first. If you want to attach this 
information to the log file:

¨ Fill in the required information on this screen and click Add, or
¨ If the screen already has all required information, click Add.

If you have already attached this information or do not want to attach it:
¨ Click Continue to continue to the Print dialog.

Select the appropriate options to print the log file, such as:
¨ Printer
¨ Print Range
¨ Print Quality
¨ Copies.

Click Setup to select a printer and set its options.



Print Preview Command - File Menu

Use this command to display an image of the Delrina TEST Log File. A series of buttons is available to manipulate 
the image, as shown below.

Goes to the Print dialog.

Displays the next page of the file.

Displays the previous page of the file.

Displays two pages of the file, side-by-side. When two-page display is selected, the button will read One Page.

 
Increases the size of the image.    To zoom in on a specific area, click on the area with the magnify pointer.

Decreases the size of the image.

Closes the preview window.



Print Setup Command - File Menu

Use this dialog to select a printer and set its options, such as:

¨ Printer
- Default Printer
- Specific Printer

¨ Orientation
- Portrait
- Landscape

¨ Paper
- Size
- Source

Additional options are available depending on the printer selected.



Print Options

Additional options are available depending on the printer selected.



 Fax Command - File Menu

Use this command to fax the current Delrina TEST Log File. 

When you select the Fax command, the Customer Information dialog appears first. If you want to attach this 
information to the log file:

¨ Fill in the required information on this screen and click Add, or
¨ If the screen already has all required information, click Add.

If you have already attached this information or do not want to attach it:
¨ Click Continue to continue to the Print dialog.

Select the appropriate options to print the log file to your fax device, such as:
¨ Printer
¨ Print Range

Click OK to go to the Delrina WinFax PRO Send dialog. Fill in the required information and click Send to send the 
fax.



Exit Command - File Menu

Use this command to exit the Delrina TEST utility. The log file is saved automatically and will be re-opened the next 
time Delrina TEST is run.



Tools Menu

For more information, click a command on the menu shown below.



 Start Tests Command - Tools Menu

Use this command to start the tests of your system.

Automatic Mode

If Delrina TEST has been setup to run in automatic mode, a message screen appears to advise you of status 
information while the tests are running. No other dialogs are displayed using Automatic Mode. The test results will 
be stored in the Delrina TEST log file.

Note: To run Delrina TEST in automatic mode, select Options from the Tools Menu and enable the Automatic 
Mode option .

Interactive Mode

If Delrina TEST has been setup to run in interactive mode, the following Tests dialog appears to allow you to select 
which tests should be run. Additional dialogs appear, depending on the tests you have selected. For more 
information, click an area in the screen image shown below.



 Modem Command Mode - Tools Menu

Use this dialog to send commands directly to your modem. When you choose Modem Command Mode, the Select 
Serial Ports dialog appears. Select the appropriate COM port. (Only the first selected COM port will be used.) Click 
OK and the Modem Command Mode dialog appears.

Enter the modem command in the Command field and click Query to send the command to the modem. Click 
Close to cancel this dialog.



 Find Command - Tools Menu

Use this dialog to locate specific information in the Delrina TEST Log File.

Type the text string you wish to find in the Find What box, or select a predefined text string from the Find What 
dropdown list box. Click Find Next. The first occurrence of the text string will be highlighted in the log file.

If the text cannot be found, the following message appears.

"The search string was not found. Select OK to search from the top or Cancel to stop."



Find Next Command - Tools Menu

Use this command to find the next occurrence of text which you previously entered in the Find dialog.

If the text cannot be found, the following message appears.

"The search string was not found. Select OK to search from the top or Cancel to stop."



Include Files Command - Tools Menu

Use this dialog to select text files to be copied into the Delrina TEST Log File. This information can help Delrina 
Technical Support staff by giving them additional information about your system.

Select WIN.INI, SYSTEM.INI or OTHER to indicate which files should be included. To specify the OTHER files, 
click Select.



Open

Use this dialog to select the additional files to be included in the Delrina TEST Log File.



Customer Information Command - Tools Menu

Use this dialog to add user profile information and a problem description to the Delrina TEST Log File, such as:
¨ Name
¨ Company
¨ Phone Number
¨ Fax Number
¨ Present Location
¨ Area Code
¨ CompuServe ID
¨ License Number
¨ Case Number
¨ Problem Description and Notes.

If you want to attach this information to the log file:
¨ Fill in the required information on this screen and click Add, or
¨ If the screen already has all required information, click Add.

If you have already attached this information or do not want to attach it:
¨ Click Continue to close this dialog without copying the information to the log file.



Options Command - Tools Menu

Use this dialog to set the options for all Delrina TEST sessions, such as:

¨ Automatic Mode Select Automatic Mode to allow all tests to be run without providing additional 
detail and interaction.

¨ Clear Log Select Clear Log to create a new log each time the tests are run.



 Help Menu

For more information, click a command on the menu shown below.



Help Contents Command - Help Menu

Use this command to go to the contents page of the Help file.



About Command - Help Menu

Use this command to get information about the Delrina TEST utility. The screen contains the release date and 
version number of the program.



 Procedures

When you start the Delrina TEST utility, the Welcome to Delrina Tests dialog appears.

Click OK to start the tests immediately. If you want to change some options before running the tests, or print/fax an 
existing log file, click Cancel to cancel the test procedure.

For more information on using the Delrina TEST Utility, click one of the following topics:

Using Delrina TEST
Modem Tests
Settings Tests
System Tests
Tests Complete
Delrina TEST Log File
Getting Help



 Using Delrina TEST

The Delrina TEST utility is used to identify the communication hardware, modem settings, system settings and 
configuration files used on your system. The following tests can be run:

¨ Modem Tests - find and test the fax/modem
¨ Settings Tests - check the settings in the startup files
¨ System Tests - get information about the system.

This information can help Delrina Technical Support staff to assist you with configuration issues or problems. The 
dialogs and messages displayed on your screen while running these tests will depend on whether you select 
Automatic or Interactive Mode.

When the tests are completed, a Tests Complete dialog appears with a summary of test results.

When you run Delrina TEST, it creates a log file which contains the results of all tests. You can also select options to 
include copies of your configuration files, such as WIN.INI, SYSTEM.INI and others. The file is called 
DELTEST.LOG and is stored in your \WINDOWS directory. 

When the log file is completed, you can:
¨ print the file for reference while on the phone with Technical Support
¨ print the file and fax it to Technical Support
¨ fax the file to Technical Support using WinFax.



Modem Tests

When you start the tests, a series of dialogs are displayed. Some allow you to choose various options and others 
display test result information as the tests are being performed. The dialogs and messages displayed on your screen 
while running these tests will depend on whether you select Automatic or Interactive Mode.

The first dialog allows you to select the COM ports to be tested
¨ Select Serial Ports

If the COM port you select does not have a modem attached, the following dialogs are displayed:
¨ Serial Port
¨ Modem Response Test
¨ COMx Test Results

If the COM port you select has a modem attached, the following dialogs are displayed:
¨ Serial Port
¨ Modem Response Test
¨ Modem Class Test
¨ Modem Speed Test
¨ Modem Manufacturer Tests
¨ COMx Test Results

Note: A Transmission dialog will flash briefly during various tests to indicate that information is being sent to and 
from the modem or COM port.



Settings Tests

The Settings tests copy selected portions of the following files into the log file:

¨ SYSTEM.INI
¨ WIN.INI
¨ WINFAX.INI
¨ AUTOEXEC.BAT
¨ CONFIG.SYS



System Tests

The System tests identify the following and write the information to the log file:

¨ CPU
¨ operating systems
¨ memory
¨ resources
¨ network type
¨ local and network drives
¨ active tasks
¨ environment settings.



Tests Complete

When all the tests are completed, a Tests Complete dialog appears.    The top portion of the dialog indicates the 
location of the DELTEST.LOG file.

The Test Summary section indicates the following:
¨ COM port used by your fax/modem
¨ type of fax/modem
¨ system processor type
¨ Windows version and mode
¨ Windows resources available

This information will vary depending on which tests were run.



Delrina TEST Log File

The log file is generated when the Delrina TEST utility is run. It contains the results of all tests, as well as 
configuration file information and system settings. The file is called DELTEST.LOG and is stored in your 
\WINDOWS directory as a text file.

You can create a new file each time tests are run, or append the new information to the end of the previous file. To 
set the option you prefer, select Options from the Tools menu.

To view the file before printing or faxing, select Print Preview from the File menu.

Be sure to have the log file available before calling Delrina Technical Support.    If you are contacting Delrina 
Technical Support by fax or Compuserve, send the DELTEST.LOG and WINFAX4.LOG as well.

Note: The Install Log icon in the WinFax group on your Windows desktop displays the WINFAX4.LOG file. This 
file contains details about the hardware and software with which you installed WinFax, the choices you 
made during installation, and the tasks performed by the WinFax Setup program. This file is created 
automatically when you run the Setup program.

See also
Getting Help



Getting Help

In you encounter a problem using WinFax, try to help yourself before calling Delrina Technical Support. Save time 
-- and maybe even the call -- by following these steps:

¨ Check WinFax online help -- Help covers screen components, procedures, menus and commands, faxing 
terminology, status codes and error messages.

¨ Try troubleshooting the problem -- Check the troubleshooting chapter in the Setup Guide for a solution to 
your problem.

¨ Run Delrina TEST -- Before requesting technical support, run the Delrina TEST utility to generate a report 
(DELTEST.LOG) of your hardware/system setup. This report helps Delrina technical representatives 
diagnose and solve your problem faster.

See also
Gathering the Required Information
Delrina Technical Support



Gathering the Required Information

Before contacting Delrina Technical Support, gather the following information:
¨ Have your WinFax PRO registration number handy.
¨ Print or open the DELTEST.LOG file created by the Delrina TEST Utility.
¨ Print or open the WINFAX4.LOG file created by the WinFax Setup program.
¨ Make note of any changes you made to your computer and your Windows setup prior to your problem.
¨ If you can reproduce the problem, make note of the sequence of steps.
¨ Make note of any error or fax status messages that appeared on the screen when the problem occurred.

Delrina Technical Support may also ask you for some or all of the following details:
¨ computer brand and model name, CPU type, clock speed and bus type
¨ fax/modem manufacturer and model name
¨ hardware attached to the other COM ports on your computer
¨ DOS and Windows versions on your computer
¨ dates from the WinFax PRO About dialog (displayed by choosing About from the Help menu in each 

WinFax program module.

See also
Delrina Technical Support



Delrina Technical Support

Refer to this quick reference table when you need to use Delrina's Technical Support services.

Service To Contact

Compuserve Enter GO DELRINA … then select the appropriate section.

Delrina Bulletin Board Dial (416) 441-2752. Set your modem to:
Service (BBS) Data bits=8, No parity, Stop bits=1.

Delrina Fax InfoLine Dial (416) 443-1614. Call from a touch tone phone and follow the instructions to 
receive a quick fax reply to your information request.

Fax Support Send to (416) 441-0774.

Telephone Support Call (416) 443-4390.

Note: 416 is a Toronto, Ontario area code.



Initiates online help and goes to the Help Contents screen.



 Troubleshooting

Check the settings for each of the ports on your system to ensure that they are not in conflict. Each port must have 
different settings for Base I/O Port Address and IRQ.

¨ From the Windows Main group, double click the Control Panel icon.
¨ From the Control Panel, double click the Ports icon.
¨ Select COM1. Click Settings. Click Advanced.
¨ Check for duplicate settings of Base I/O Port Address and IRQ.
¨ Click Cancel twice.
¨ Repeat the last three steps for each COM port.
¨ If there is no device on the port, change the settings to "Default".

This hardware conflict may cause intermittent problems with communications through your modem. Advise your 
technician or Delrina Technical Support representative that you received this warning message.




